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151. _________ allows users to upload files to an online site 

so they can be viewed and edited from another location. 

(1) General-purpose applications 

(2) Microsoft outlook 

(3) Web-hosted technology 

(4) Office Live 

(5) None of these 

152. What feature adjusts the top and bottom margins so 

that the text is centered vertically on the printed page? 

(1) Vertical justifying  

(2) Vertical adjusting 

(3) Dual centering  

(4) Horizontal centering 

(5) Vertical centering 

153. Which of these is not a means of personal 

communication on the Internet? 

(1) chat 

(2) instant messaging 

(3) instanotes 

(4) electronic mail 

(5) None of these 

154. What is the overall term for creating, editing, 

formatting, storing, retrieving, and printing a text 

document? 

(1) Word processing  

(2) Spreadsheet design 

(3) Web design  



 

 

(4) Database management 

(5) Presentation generation 

155. Fourth-generation mobile technology provides 

enhanced capabilities allowing the transfer of both data, 

including full-motion video, high-speed Internet access, and 

videoconferencing. 

(1) video data and information 

(2) voice and non-voice 

(3) music and video 

(4) video and audio 

(5) None of these 

156. _________ is a form of denial of service attack in which 

a hostile client repeatedly  attack in which a hostile client 

repeatedly sends SYN packets to every port on the server, 

using fake IP addresses.  

(1) Cybergaming crime  

(2) Memory shaving 

(3) Syn flooding  

(4) Software piracy  

(5) None of these 

157. Which of these is a point-and-draw device? 

(1) mouse  

(2) scanner  

(3) printer  

(4) CD-ROM  

(5) keyboard 

158. The letter and number of the intersecting column and 

row is the 

(1) cell location  

(2) cell position  

(3) cell address  

(4) cell coordinates  

(5) cell contents 



 

 

159. A set of rules for telling the computer what operations 

to perform is called a 

(1) procedural language  

(2) structures 

(3) natural language  

(4) command language 

(5) programming language 

160. A detailed written description of the programming cycle 

and the program, along with the test results and a printout 

of the program is called 

(1) documentation  

(2) output  

(3) reporting  

(4) spec sheets  

(5) directory 

161. Forms that are used to organise business data into rows 

and columns are called 

(1) transaction sheets  

(2) registers  

(3) business forms  

(4) sheet-spreads  

(5) spreadsheets 

162. In PowerPoint, the Header & Footer button can be 

found on the Insert tab in what group? 

(1) Illustrations group  

(2) Object group 

(3) Text group  

(4) Tables group (5) None of these 

163. A(n)_____ is a set of programs designed to manage the 

resources of a computer, including starting the computer, 

managing programs, managing memory, and coordin-ating 

tasks between input and output devices. 



 

 

(1) application suite  

(2) compiler 

(3) input/output system  

(4) interface  

(5) operating system (OS) 

164. A typical slide in a slide presentation would not include 

(1) photo images, charts and graphs 

(2) graphs and clip art 

(3) clip art and audio clips 

(4) full-motion video 

(5) content templates 

165. The PC productivity tool that manipulates data 

organised in rows and columns is called a(n) 

(1) spreadsheet 

(2) word processing document 

(3) presentation mechanism 

(4) database record manager 

(5) EDI creator 

166. In the absence of parentheses, the order of operation is 

(1) exponentiation, addition or subtraction, multiplication or division 

(2) addition or subtraction, multiplication or division, exponentiation  

(3) multiplication or division, exponen-tiation, addition or subtraction 

(4) exponentiation, multiplication or divi-sion, addition or subtraction 

(5) addition or subtraction, exponentiation, multiplication or division 

167. To find the Paste Special option, you use the Clipboard 

group on the _______ tab of PowerPoint. 

(1) design  

(2) slide Show  

(3) page layout  

(4) insert  

(5) home 

168. A(n) program is one that is ready to run and does not 

need to be altered in any way.  



 

 

(1) interpreter  

(2) high-level  

(3) compiler  

(4) COBOL  

(5) executable 

169. Usually downloaded into folders that hold temporary 

Internet files,_________ are written to your computer’s hard 

disk by some of the Web sites you visit. 

(1) anonymous files  

(2) behaviour files 

(3) banner ads  

(4) large files 

(5) cookies 

170. What is the easiest way to change the phrase “revenues, 

profits, gross margin,” to read “revenues, profits, and gross 

margin”? 

(1) Use the insert mode, position the cursor before the g in gross, then type the word and 

followed by a space 

(2) Use the insert mode, position the cursor after the g in gross, then type the word and followed 

by a space 

(3) Use the overtype mode, position the cursor before the g in gross, then type the word and 

followed by a space 

(4) Use the overtype mode, position the cursor after the g in gross, then type the word and 

followed by a space 

(5) None of these 

171. A program, either talk or music, that is made available 

in digital format for automatic download over the Internet is 

called a 

(1) wiki  

(2) broadcast  

(3) vodcast  

(4) bIog  

(5) podcast 



 

 

172. Which PowerPoint view displays each slide of the 

presentation as a thumbnail and is useful for rearranging 

slides? 

(1) Slide sorter  

(2) Slide show  

(3) Slide master  

(4) Notes page  

(5) Slide design 

173. Different components on the motherboard of a PC unit 

are linked together by sets of parallel electrical conducting 

lines. What are these lines called? 

(1) Conductors  

(2) Buses  

(3) Connectors  

(4) Consecutives  

(5) None of these 

174. What is the name given to those applications that 

combine text, sound, graphics, motion video, and/or 

animation? 

(1) motionware  

(2) anigraphics  

(3) videoscapes  

(4) multimedia  

(5) maxomedia 

175. A USB communication device that supports data 

encryption for secure wireless commu-nication for notebook 

users is called a 

(1) USB wireless network adapter 

(2) wireless switch 

(3) wireless hub 

(4) router 

(5) None of these 



 

 

176. A(n) language reflects the way people think 

mathematically. 

(1) cross-platform programming 

(2) 3GL business programming 

(3) event-driven programming 

(4) functional 

(5) None of these 

177. When entering text within a document, the Enter key is 

normally pressed at the end of every 

(1) line  

(2) sentence  

(3) paragraph  

(4) word  

(5) file 

178. When a real-time telephone call between people is made 

over the Internet using computers, it is called 

(1) a chat session  

(2) an e-mail 

(3) an instant message  

(4) internet telephony 

(5) None of these 

179. Which of the following is the first step in sizing a 

window? 

(1) Point to the title bar 

(2) Pull down the View menu to display the toolbar 

(3) Point to any corner or border 

(4) Pull down the View menu and change to large icons 

(5) None of these 

180. Which of the following software could assist someone 

who cannot use their hands for computer input? 

(1) Videoconferencing  

(2) Speech recognition 



 

 

(3) Audio digitizer  

(4) Synthesizer 

(5) None of these 

181. ......... a document means the file is transferred from 

another computer to your computer. 

(1) Uploading 

(2) Really Simple Syndication (RSS) 

(3) Accessing 

(4) Downloading 

(5) Upgrading 

182. Which computer memory is used for storing programs 

and data currently being processed by the CPU? 

(1) Mass memory 

(2) Internal memory 

(3) Non-volatile memory 

(4) PROM 

(5) None of these 

183. Computers that control processes accept data in a 

continuous 

(1) data traffic pattern  

(2) data highway 

(3) infinite loop  

(4) feedback loop  

(5) slot 

184. What refers to a set of characters of a particular 

design?  

(1) Keyface  

(2) Formation  

(3) Calligraph  

(4) Stencil  

(5) Typeface 



 

 

185. ........ is used by public and private enterprises to publish 

and share financial information with each other and 

industry analysts across all computer platforms and the 

Internet. 

(1) Extensible Markup Language (XML) 

(2) Extensible Business Reporting Language (XBRL) 

(3) Enterprise Application Integration (EAI) 

(4) Sales Force Automation (SKA) software 

(5) None of these 

186. Which part of the computer is used for calculating and 

comparing? 

(1) ALU  

(2) Control unit  

(3) Disk unit  

(4) Modem  

(5) None of these 

187. The method of Internet access that requires a phone 

line, but offers faster access speeds than dial-up is the 

connection. 

(1) cable access 

(2) satellite access 

(3) fibre-optic service 

(4) digital subscriber line (DSL) 

(5) modem 

188. ............. software creates a minor image of the entire 

hard disk, including the operating system, applications, files, 

and data. 

(1) Operating system  

(2) Backup software 

(3) Utility programs  

(4) Driver imaging  

(5) None of these 



 

 

189. What is a URL? 

(1) A computer software program 

(2) A type of programming object 

(3) The address of a document or “page” on the World Wide Web 

(4) An acronym for Unlimited Resources for Learning 

(5) A piece of hard ware 

190. What is the significance of a faded (dimmed) command 

in a pull-down menu? 

(1) The command is not currently accessible. 

(2) A dialog box appears if the command is selected. 

(3) A Help window appears if the command is selected. 

(4) There are no equivalent keystrokes for the particular command. 

(5) None of these 

191. Your business has contracted with another company to 

have thorn host and run an application for your company 

over the Internet. The company providing this service to 

your business is called an 

(1) internet service provider 

(2) internet access provider 

(3) application service provider 

(4) application access provider 

(5) outsource agency 

192. A(n) ............. allows you to access your e-mail from 

anywhere. 

(1) forum  

(2) webmail interface 

(3) message board  

(4) weblog  

(5) None of these 

193. Which of the following would you find on Linkedln? 

(1) Games  

(2) Connections 



 

 

(3) Chat  

(4) Applications 

(5) None of these 

194. ............. is a technique that is used to send more than 

one call over a single line. 

(1) Digital transmission  

(2) Infrared transmission 

(3) Digitizing  

(4) Streaming  

(5) Multiplexing 

195. The Search Companion can 

(1) locate all files containing a specified phrase 

(2) restrict its search to a specified set of folders 

(3) locate all files containing a specified phrase and restrict its search to a specified set of folders 

(4) cannot locate all files containing a specified phrase or restrict its search to a specified set of 

folders 

(5) None of these 

196. Which of the following cannot be part of an email 

address? 

(1) Period (.)  

(2) At sign (@)  

(3) Space ()  

(4) Underscore (_)  

(5) None of these 

197. Which of the following must be contained in a URL? 

(1) A protocol identifier 

(2) The letters www 

(3) The unique registered domain name 

(4) www. and the unique registered domain name 

(5) A protocol identifier, www. and the unique registered domain name 

198. Which of the following information systems focuses on 

making manufacturing processes more efficient and of 

higher quality? 



 

 

(1) Computer-aided manufacturing 

(2) Computer-integrated manufacturing 

(3) Computer-aided software engineering 

(4) Computer-aided system engineering 

(5) None of these 

199. A mistake in an algorithm that causes incorrect results 

is called a 

(1) logical error  

(2) syntax error  

(3) procedural error  

(4) compiler error  

(5) machine error 

200. A device for changing the connection on a connector to 

a different configuration is 

(1) a converter  

(2) a component  

(3) an attachment  

(4) an adapter  

(5) voltmeter 

 


